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    Chapter 11   

 Genetic Labeling of Synapses 

           Carlos     Lois      and     Wolfgang     Kelsch    

    Abstract 

   A major challenge in neuroscience is to unravel how the synaptic contacts between neurons give rise to 
brain circuits. A number of techniques have been developed to visualize the synaptic organization of neu-
rons. In this chapter, we focus on genetic methods to mark specifi c types of synapses so that synaptic sites 
can be visualized throughout the entire dendritic or axonal arbor of single neurons. Genetic synaptic label-
ing can be achieved by cell-type-specifi c viral or transgenic delivery of synaptic proteins tagged by fl uores-
cent proteins. Sparse genetic labeling of neurons permits semiautomated quantifi cation of the distribution 
and densities of selected types of synapses in segregated domains of the axonal and dendritic trees. These 
approaches can reduce the complexity and ambiguity of attributing synaptic sites to unravel principles of 
the synaptic organization of identifi ed neuronal types in the circuit.  

  Key words     Synaptic organization  ,   Synaptic markers  ,   Neurons  ,   Genetic synaptic labeling  , 
  Synaptophysin  ,   PSD-95  ,   Retroviruses  

1      Introduction 

 A central hurdle toward understanding brain function is the com-
plex organization of synaptic contacts between neurons that form 
circuits. A plethora of techniques have been developed to solve this 
challenging task of deciphering the synaptic organization of single 
neurons and mapping synaptic connectivity in neuronal circuits. In 
this chapter, we will focus on recently developed genetic markers to 
identify synaptic contacts and discuss their caveats and limitations. 

 Traditionally, three main approaches, morphological correlates 
of synapses, antibody staining, and electron microscopy, had been 
employed to describe or infer synaptic contacts of neurons:

    1.    In some cases, synapses can be identifi ed on the basis of their 
association with neuronal structural specializations. For instance, 
many excitatory input synapses are located in dendritic spines, in 
which case spines may be used as a morphological proxy for 
synapses. One limitation of this method is that a large propor-
tion of synapses, such as excitatory input synapses on cell somata 
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and inhibitory synapses, are not associated with spines [ 1 ,  2 ]. 
In addition, morphological methods are not useful to quantify 
output synapses, which are mostly located in axon terminals 
(Ref?). It is easy to identify axon terminals, but it is not possible 
to accurately quantify the density and measure the size of output 
synapses by simple morphological analyses. Similarly, the extent 
of overlap between axons and postsynaptic dendrites has been 
used to infer the presence of synaptic connectivity based on the 
fact that synapse formation requires a physical proximity. 
However, ultrastructural studies reveal that axons and dendrites 
frequently approach each other without making synapses. For 
example, in several well-studied systems like C. elegans, the rat 
hippocampus, or the mouse retina, only 15–25 % of physical 
contacts are synaptic [ 3 – 5 ]. Thus, close proximity between neu-
rons cannot be used to reliably identify synapses.   

   2.    Antibody labeling against synaptic markers is a powerful 
method to label synapses in cultured neurons. However, this 
method is suboptimal in brain sections because the large num-
ber of synapses present severely complicates the attribution of 
synapses to individual new neurons.   

   3.    Electron microscopy (EM) represents the “gold standard” 
assay for identifying synapses but its main disadvantages are 
that it is labor intensive, can only be applied to fi xed (nonliv-
ing) tissue, and cannot be used to trace long-range connec-
tions (see also below    section “Electron Microscopy”).     

 The limitations of these methods have driven the ongoing 
development of tools to genetically label the synapses of identifi ed 
neurons. 

 Recently developed genetic approaches to visualize synapses 
fall into two broad categories depending on the experimental 
demand:

 –    Visualizing specifi c types of synapses (i.e., glutamatergic input 
synapses or gabaergic output synapses) in single neurons.  

 –   Visualizing the synaptic contacts between neurons by genetic 
labeling of both the pre- and postsynaptic neurons.    

 These approaches reduce the complexity and ambiguity of 
attributing synaptic sites by genetically targeting a very small sub-
set of neurons in the examined tissue. In this chapter we will dis-
cuss these two genetic approaches considering their potential 
applications and respective limitations.  

2    Genetic Labeling of the Synaptic Organization of Single Neurons 

 Labeling synapses with genetically encoded markers addresses 
some of the limitations of the abovementioned techniques and sig-
nifi cantly simplifi es the quantifi cation of synaptic organization and 
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development in neurons [ 6 – 9 ]. The visualization of pre- and post-
synaptic terminals can be achieved via expression of fl uorescent 
proteins fused to proteins specifi cally located in synapses. 

  Few synaptic proteins have been extensively tested for their use as 
genetic synaptic markers. We will particularly focus here on two 
synaptic proteins fused to fl uorescent proteins that have been suc-
cessfully applied in us and others. The fi rst one, PSD-95, is a scaf-
folding protein restricted to clusters in the postsynaptic density of 
most glutamatergic synapses [ 9 – 13 ]. The second protein, synapto-
physin, can be used to identify release sites on axon terminals as it 
is selectively localized at presynaptic terminals [ 14 ]. 

  To visualize glutamatergic input synapses, we and others have 
expressed a PSD-95-GFP fusion protein. PSD-95 is a scaffolding 
protein that localizes to the postsynaptic density of glutamatergic 
synapses [ 12 ] and has been extensively used as a postsynaptic 
marker of glutamatergic synapses [ 9 – 11 ,  13 ] both for confocal 
imaging in fi xed tissue and in vivo imaging. 

 PSD-95-GFP-positive clusters overlap with endogenous PSD- 
95 expression. PSD-95-GFP-positive clusters are contacted by the 
presynaptic marker bassoon and are concentrated at asymmetric 
synapses at the ultrastructural level [ 6 ,  7 ]. Furthermore PSD-95 is 
already highly expressed at birth [ 15 ]. Thus, PSD-95-GFP is useful 
to follow synaptic development as neurons start to differentiate 
because it appears early during assembly of the postsynaptic density. 
For example, expression of PSD-95-GFP fusion protein in progeni-
tor cells with retroviruses was a useful method to investigate the 
dynamics of synapse formation in newly generated neurons pro-
duced in the brain of adult mice [ 16 ]. Other postsynaptic proteins 
like SAP-102 fusion proteins can complement PSD-95- GFP to 
monitor synapse formation, as they are expressed with a different 
temporal profi le during maturation of glutamatergic synapses. 

 Finally, retroviral expression of PSD-95-GFP did not change 
the strength and number of glutamatergic synapses in cultured 
neurons [ 6 ]. The absence of a direct effect of the synaptic marker 
on synapse number and stability is critical for many experiments, 
since it has been reported in cultured hippocampal neurons that 
fi ve- to tenfold overexpression of PSD-95 by transient transfection 
led to strengthening or increase in the number of AMPA receptor- 
mediated mEPSCs [ 17 ]. Our experiments revealed that the  modest 
level of expression achieved with retroviral expression did not 
change the strength or number of AMPA receptor-mediated mEP-
SCs in vitro, further supporting the idea that PSD-95-GFP can be 
used to genetically label postsynaptic sites. Thus, in all strategies 
utilizing fusion proteins as genetic markers of synapses, there is a 
critical balance to achieve, because it is necessary to obtain suffi -
cient expression so that the fusion protein can be reliably detected, 
but low enough not to interfere with normal cell function. 

2.1  Molecular 
Targets for Genetic 
Labeling of Synapses

 Postsynaptic Targets 
for Excitatory Synapses
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 To the best of our knowledge, other candidate fusion proteins 
are less established for labeling of glutamatergic synapses. For 
example, one could imagine visualization of specifi c subsets of glu-
tamatergic neurons during development. Glutamatergic synapses 
are characterized by sequential addition of NMDA receptor sub-
units GluN2B followed by GluN2A. Both NMDA receptor sub-
units can be engineered as fusion proteins and cluster at the 
expected sites where glutamatergic synapses are regularly found 
[ 18 ]. However, in contrast to PSD-95-GFP fusion protein, over-
expression of these fusion proteins have overt effects on neuronal 
maturation [ 18 ]. Hence, the effects of the expressed fusion protein 
itself on synapse properties like elimination or strengthening are 
important to consider. Certain of these effects may be mitigated by 
directed mutagenesis of the synaptic marker, but there is the pos-
sibility that dominant negative effects (such as sequestration of 
interacting proteins) could occur.  

  In contrast to the well-established marker PSD-95-GFP for gluta-
matergic synapses, less is known about equivalent marker for inhib-
itory synapses. A scaffolding protein of inhibitory synapses, 
gephyrin, may be useful [ 19 ], but a thorough characterization is 
necessary to confi rm whether gephyrin only clusters at synapses or 
whether it also clusters at signifi cant levels, i.e., in the cytoplasm. 
In addition, it has not been determined the fraction of GABAergic 
synapses that are actually labeled by this marker. Finally, it is not 
known the extent by which gephyrin labels synapses as neurons 
mature. Other promising candidates may be GABA A -receptor sub-
units fused to fl uorescent proteins [ 20 ]. It is however important to 
again consider direct effects of these receptor fusion proteins on 
synapse function or maintenance [ 21 ]. Similar gain-of-function 
problems can arise if other structural synaptic proteins, like neurex-
ins or neuroligins, are used as marker proteins (see also next section 
on GRASP).  

  Presynaptic synapses (output synapses) can be labeled by a 
synaptophysin- GFP fusion protein. Synaptophysin is a 38 kDa syn-
aptic vesicle glycoprotein that is expressed in virtually all neurons in 
the brain and spinal cord [ 14 ]. Despite its well-known interaction 
with the essential synaptic vesicle protein synaptobrevin, the exact 
function of synaptophysin remains unclear as it is not an obligatory 
protein for vesicle formation or fusion [ 22 ,  23 ]. Synaptophysin-
GFP has been extensively used to study the distribution and density 
of presynaptic sites in neurons both in vitro and in vivo [ 8 ,  24 – 26 ]. 
There is currently no indication that its overexpression results in 
gain of additional synapses. Its expression is nearly ubiquitous in all 
presynaptic sites in contrast to other presynaptic marker proteins 
like Bassoon. Finally, it appears relatively early during synapse for-
mation [ 27 ]. A previous study that examined synapse formation in 

 Postsynaptic Targets 
for Inhibitory Synapses

 Presynaptic Targets 
for Release Sites
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zebra fi sh indicated that transient clusters are formed in the cytosol 
of developing axons potentially indicating transport of pre-clustered 
synaptic proteins to the terminals [ 8 ]. Such transient clustering 
should be considered when studying initial synapse formation.   

  For certain questions the visualization of synaptic contacts between 
two types of neurons is critical. For this purpose, complementary 
genetic labeling techniques have been developed. 

  A technique that has recently gained substantial attention is retro-
grade transsynaptic labeling using genetically modifi ed rabies 
viruses, also called “monosynaptic tracing” [ 28 ]. Monosynaptic 
tracing is reviewed in detail in a separate chapter of this book, and 
here we will focus on its current limitations and opportunities. 
This method has currently several drawbacks that have to be con-
sidered when applying this technique in its current state [ 29 ]. 
Replication of rabies viruses interferes with the protein synthesis 
machinery of the host cell, thus limiting the time window between 
its initial expression until the death of the labeled neurons to a few 
days [ 30 ].Thus, it is important to be aware of the effects of rabies 
replication on the health of the neuron for any imaging and func-
tional studies . Also, once the virus jumps to a presynaptic cell, that 
cell will remain labeled independently of whether the synaptic con-
tact is lost [ 29 ]. Particularly during states of high synapse turnover 
such as during development, this technique can be used to sample 
the cumulative history of previous and current synaptic partners. 
Finally, it appears that rabies virus do not cross over all the syn-
apses. For example, cortical pyramidal cells are estimated to have 
approx. 10,000 presynaptic partners, but transsynaptic labeling 
with rabies only reveals hundreds of presynaptic cells [ 31 ]. Similarly 
it is not clear whether rabies viruses will cross different types of 
synapses with the same effi ciency [ 29 ]. Again, once these con-
straints are better understood, they could provide further insight 
into synaptic properties and their distribution.  

  Another approach that has been initially developed in C. elegans is 
“GFP Reconstitution Across Synaptic Partners” (GRASP) [ 32 ]. 
GRASP genetically labels synaptic partners utilizing a two- 
component synaptic labeling system [ 33 ]. GRASP takes advantage 
of a version of GFP divided into two fragments that can emit fl uo-
rescence only when the two halves of GFP are combined. To visu-
alize exclusively synaptic contacts, the two GFP fragments need to 
be appended to the extracellular domains of transmembrane pro-
teins that localize to synapses. GRASP labeling matched ultrastruc-
tural synaptic contacts in C. elegans circuits [ 32 ,  34 ]. GFP 
fl uorescence requires no exogenous cofactors and therefore can be 
monitored in vivo like other fl uorescent genetic synaptic marker 

2.2  Genetic Labeling 
of Contact Between 
Synaptic Partner 
Neurons

 Transsynaptic Labeling 
with Replication- Defi cient 
Rabies Vectors

 GFP Reconstitution Across 
Synaptic Partners (GRASP)

Genetic Labeling of Synapses



236

proteins. GRASP has now been modifi ed for application in 
C.  elegans, Drosophila, and, most recently, mouse. In transgenic 
mice [ 35 ,  36 ] the GRASP system currently appears to have low 
sensitivity. Although signals in especially large photoreceptor syn-
apses are robust, known contacts at smaller synapses in the inner 
plexiform layer of the retina, the spinal, or the cortex using other 
Cre transgenic lines were not detected potentially due to insuffi -
cient expression of the 2 GRASP partners [ 36 ]. In contrast, using 
high levels of expression via adeno-associated viral vectors, it is 
possible to detect GRASP signals with higher sensitivity in the 
mouse hippocampus and cortex [ 35 ]. 

 Finally, an important concern regarding GRASP is the poten-
tial stabilization of otherwise transient cell-cell contacts, as the 
binding of the two elements of the split GFP is irreversible. Thus, 
the two components of the GRASP system act as a strong cell 
adhesion complex that will keep cell permanently attached to each 
other. This may become particularly important in dynamic situa-
tions such as during brain development where a large fraction of 
synapses is usually eliminated before achieving the eventual synap-
tic organization. In summary, GRASP is a promising technique to 
visualize synaptic connections between neurons that might become 
widely useful once several key technical limitations are solved.    

3    Comparison with Other Techniques 

  As already stated above conventional antibody labeling of synaptic 
proteins in vibratome or frozen tissue sections by light microscopy 
has two major drawbacks. First, it relies on antibodies against syn-
aptic proteins. However, most antibodies against synaptic proteins 
that work in cultured neurons do not work well in tissue sections. 
Second, it is frequently impossible to see the “tree in the forest” 
due to the extremely high density of labeling in tissue sections, 
which makes it impossible to attribute or even quantify the number 
of synaptic sites of single neurons. 

 Emerging imaging techniques like “array tomography” [ 37 ] 
may be able to overcome some of these problems. Array tomogra-
phy is a volumetric microscopy method based on physical serial 
sectioning. Ultrathin sections (50–200 nm) of a plastic-embedded 
tissue are cut using an ultramicrotome and bonded in an ordered 
array to a glass coverslip. Due to the ultrathin sectioning, antibody 
labeling is substantially improved as antibodies penetrate effi ciently 
through the sections. Because these arrays are very effectively sta-
bilized by the glass substrate, they can withstand many repeated 
cycles of staining, imaging, and elution. This permits using many 
antibodies serially (20 or more) to each individual section. 

 The resulting two-dimensional image tiles can then be recon-
structed computationally into three-dimensional volume images 

3.1  Histological 
Approaches 
to Visualize 
the Synaptic 
Organization 
of Neurons
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for visualization and quantitative analysis. However, “array 
tomography” relies on the effi ciency of antibody staining and 
preservation of tissue antigenicity and can result in potentially 
ambiguous and incomplete results. 

 Electron microscopy is technically more challenging than 
imaging by light microscopy but allows for high-resolution analysis 
of pre- and postsynaptic sites by visualizing synaptic vesicles and 
postsynaptic sites, respectively. Conventional EM using serial sec-
tions has been used, for example, to reconstruct the whole set of 
individual synapses between single adult-born neurons and their 
synaptic partners [ 38 ]. However, this kind of work is extremely 
labor intensive and can only be used to reconstruct a handful of 
neurons per experiment. Recent developments within the past few 
years hint at the possibility of semiautomated sectioning and imag-
ing of large neuropil volumes [ 39 ], thus facilitating high- 
throughput ultrastructural analyses of synapses. However, only 
relatively small brain volumes can presently be imaged (on the 
order of 450 ! 350 ! 50 !m, e.g., [ 3 ]), mainly because electron 
microscopy image acquisition and analysis remain a formidable 
challenge [ 39 ]. In addition, the main limitation for the EM 
approach is that this technique focuses on the local structure under 
analysis, because long-range connections from distant parts of the 
brain cannot be analyzed. 

 There are two main advantages of electron microscopy and 
array tomography. First, these techniques provide very high- 
resolution images. Second, in contrast to genetic methods, they 
reveal brain circuits in their “native” status, without perturbing 
their function by addition of extra molecules to their synapses. 
However, both electron microscopy and array tomography are 
restricted to fi xed (dead) tissue and do not allow functional studies 
via in vivo imaging or electrophysiological recordings as is possible 
for genetic labeling of synapses. Due to the extensive tissue pro-
cessing, e.g., serial electron microscopy, caution has to be applied 
concerning nonproportional changes in extracellular due to tissue 
shrinkage and subsequent artifacts that can distort the wiring dia-
gram of circuits during semiautomated analysis [ 39 ].   

4    Delivering Genetic Synaptic Markers into Neurons 

 As outlined above delivery of genes to a small number of neurons 
and obtaining appropriate levels of expression is critical to success-
fully using genetic synaptic markers. Techniques such as gene gun 
delivery (in slices), in vivo plasmid electroporation, and adeno- 
associated viruses are less explored for genetic labeling of synapses 
as the high copy numbers of transferred genes into single neurons 
with these methods may result in unpredictable effects on synapse 
function. In addition, there is a high variation in the copy number 
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of transgenes delivered per cell using adeno-associated viruses, 
electroporation, or gene gun. Therefore, analysis of labeled syn-
apses may be complicated by the degree of variation in brightness 
of clusters among neurons. Finally, above a certain level of expres-
sion, a signifi cant level of the marker protein might be located out-
side of synaptic sites. In contrast, retroviral vectors provide 
moderate expression levels and a relative consistency in the level of 
expression between cells. Due to these advantages, retroviruses 
have been extensively used in many studies of genetic labeling of 
synapses. An alternative approach to achieve reproducibility of 
gene expression is provided by generating transgenic animal lines. 
We will therefore discuss here expression of synaptic markers by 
retroviruses and tissue-specifi c transgenesis. 

  Retroviral vectors are the most commonly used vehicle to deliver 
genetic synaptic markers into neurons. Retroviral vectors fall 
by-and- large into two popular systems: HIV-derived lentiviruses 
and Moloney oncoretroviruses. Both viral systems are replication 
defi cient, meaning that after the initial infection of a cell, they are 
not able to replicate and infect other target cells. A major differ-
ence between the two systems resides in the cells they can infect 
[ 40 ]. Whereas oncoretroviruses can only infect cells that are in the 
progress of dividing, lentiviruses can infect both quiescent and 
dividing cells. Oncoretroviruses have therefore been widely used in 
developmental biology as they allow birthdating of newly gener-
ated neurons and tracking their maturation. The packaging size of 
the inserted genes is comparable in both systems and suffi cient to 
harbor most genetic synaptic marker and an additional gene of 
interest, such as those coding for ion channels, growth factors, or 
cell adhesion molecules. Thus, by introducing both a synaptic 
marker and a gene of interest, it is possible to assess the effects of 
various manipulations on synapse formation and dynamics. 
Retroviral expression under the control of different promoter frag-
ments derived from the human synapsin, CMV, or RSV promoter 
provides appropriate levels of expression in mammals. Cell-type- 
specifi c promoters are however, despite intense search, still not 
available for most neuron types. For rodents, the CamKII  promoter 
is a good option to label excitatory neurons, but currently there is 
no good candidate promoter to label inhibitory neurons. Using 
the abovementioned promoters and retroviral systems, we have 
observed a limited variability in the brightness of the fusion pro-
teins PSD-95-GFP and synaptophysin-GFP when comparing cells 
in the same tissue section. Moreover, these differences of expres-
sion between cells had little effect on the analysis by confocal 
microscopy as the brightness of the synaptic clusters was generally 
saturating and the differences occurred largely in the mostly dim and 
diffusely distributed fusion protein fl uorescence throughout neuro-
nal processes. These low levels of diffusely distributed synaptic fusion 

4.1  Viral Delivery 
of Genetic Synaptic 
Markers
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protein do not interfere with detection of synaptic clusters, but can 
be very helpful as, in the case of in vivo imaging studies, it helps to 
visualize the neuronal tree along which synaptic clusters form [ 11 , 
 41 ]. In case of confocal analysis in fi xed tissue, the low levels of 
diffusely distributed GFP in the neuronal processes can be ren-
dered detectable by amplifying its signal with immunofl uorescent 
staining in a different color (for instance, Texas red antibodies to 
amplify the PSD-95-GFP diffuse signal) that substantially facili-
tates the reconstruction of fi ner neuronal processes.  

  Another potentially attractive approach is the generation of trans-
genic lines expressing genetic synaptic markers in selected subsets 
of neurons. This approach generally can have two advantages. 
First, transgenic animals provide reproducible levels of gene expres-
sion for a given cell type, eliminating the cell-to-cell variability dis-
cussed with viral delivery methods. Second, and more importantly, 
cell-type specifi city can be obtained by using knock-in-techniques 
or large promoter region fragments (>100 kb) for conventional 
transgenesis. The downside of most cell-type-specifi c mouse line is 
that the high density of labeled cells may make it diffi cult to recon-
struct and attribute synaptic clusters to single neurons. This limita-
tion could be overcome using transgenic strategies that result in 
stochastic and sparse expression of genetic synaptic markers, such 
as incomplete activation of inducible Cre (Nathans, Luo paper in 
PLOS ONE). For some of these model systems, the use of genetic 
synaptic markers, PSD-95-GFP and synaptophysin-GFP, has been 
successfully applied in combination with in vivo imaging to study 
synaptic development of single neurons [ 8 ].  

  For most experimental question, genetically labeled synapses need 
to be attributed to neuronal processes of single neurons. Here, 
 different approaches exist:

    1.    Immunohistochemical methods.
   (a)    For imaging the synaptic organization of single neuron’s 

visualization of the dendritic or axonal tree that contain 
the genetically labeled synapses in fi xed tissue, a simple 
method based on immunofl uorescence antibody labeling 
can be used. To attribute PSD-GFP-positive clusters to a 
particular neuron, we took advantage of the presence of 
low levels of diffuse PSD-95- GFP protein in the cyto-
plasm, which were not detectable by its endogenous fl uo-
rescence. However, this diffuse PSD-95- GFP protein can 
be easily visualized by amplifying its signal with antibodies 
raised against GFP (followed by staining with a secondary 
antibody coupled to a red or blue fl uorophore to distin-
guish it from the intrinsic green fl uorescence of PSD posi-
tive clusters) and allowed attribution of PSD-GFP clusters 
to a dendritic arbor belonging to a particular neuron.       

4.2  Generation 
of Transgenic Animals 
Expressing Genetic 
Synaptic Markers

4.3  Different Ways 
of Attributing 
Synapses to Specifi c 
Neurites
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   2.    Co-expression with membrane-tagged XFPs.
   (a)    An alternative approach is the expression of both the 

genetic synaptic marker and a membrane-tagged fl uores-
cent protein of another color. Different approaches exist to 
co- express two genes with a single retrovirus. 

 IRES: internal ribosomal entry sites can be engineered 
to obtain two different proteins from single mRNA (bicis-
tronic expression). However, this strategy is problematic in 
many cases as it is usually found that the second protein is 
expressed at much lower levels than the fi rst protein. In 
some cases it has been reported that the protein located in 
behind the IRES may be expressed at levels tenfold lower 
than the fi rst protein. 

 2A linkers: The use of T2A-linker sequences derived 
from picornaviruses is a relatively recent strategy to obtain 
bicistronic expression. In this strategy the fi rst gene is 
engineered without its stop codon, followed by a 2A 
sequence (about 18 amino acids), and fi nally followed by 
the complete coding sequence of the second gene. When 
the ribosome reaches the 2A sequence, it will release the 
fi rst protein plus the 2A sequence and will start translating 
the second protein. In contrast to IRES, the two genes 
separated by 2A sequences are expressed at similar levels. 
However, there are a few caveats for bicistronic cassettes 
with 2A sequences. First, in some situations instead of two 
independent proteins, a large fusion protein will be pro-
duced that includes the open reading frames of the fi rst 
and second proteins plus the intervening amino acids of 
the 2A sequence. Second, the fi rst protein will have an 
extra “tail” consisting of the 2A sequence at its C-terminus, 
which in some cases can affect its function. We recently 
observed that the T2A linker provides suffi cient levels of 
expression of synaptophysin- GFP and membrane-tagged 
dimeric tomato protein in a retroviral vector (unpublished 
observations,    Fig. ???). This approach may be particularly 
interesting for in vivo imaging that aims at attributing syn-
aptic clusters to processes of specifi c neurons.   

  (b)    Bicistronic expression of a synaptic genetic marker plus 
the recombinase Cre can be used to combine genetic 
synaptic labeling with conditional mouse or viral trans-
genic tools. XFP reporter lines are available that dis-
played high levels of fl uorescent protein expression 
upon Cre recombination. Cre is a highly effi cient recom-
binase, and having a low expression of it (e.g., following 
an IRES) is not problematic because it is suffi cient to 
induce recombination of the loxP sites. Thus, in this 
strategy, the XFP would be driven by a strong promoter 
in a loxP- dependent reporter transgenic mouse or virus. 
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This approach can be further expanded combining 
 multiple conditional mouse lines and/or viral condi-
tional gene delivery that is Cre dependent.          

  Two main points have to be considered when designing genetic 
synaptic markers:

    1.     Expression level: not too low and not too high (infl uence of synapse 
strength).  
 When introducing these genetically encoded markers, it is crit-
ical to ensure that only modest levels of overexpression are 
achieved because excessive levels of these proteins may inter-
fere with synaptic development or function [ 17 ]. Fortunately, 
retroviral vectors, which deliver single copies of transgenes into 
their target cells, produce modest levels of expression that are 
suffi cient to detect fl uorescent synaptic marker proteins, while 
at the same time leave synapse number and strength unper-
turbed [ 6 ].   

   2.     Infl uence on synapse stability  
 There are concerns to consider in this respect. First, expression 
of these genetic synaptic markers may infl uence the number or 
strength of synapses. For example, neuroligins are known to 
directly induce synapse formation even with nonneuronal tar-
gets [ 42 ] and thus have to be carefully tested before using 
them as fusion proteins to study synaptic development or reor-
ganization as discussed above. Second, labeling approaches 
based on the transneuronal interaction of transmembrane pro-
teins may interfere with synapse turnover. For example, an 
important drawback of GRASP is that the reconstitution of the 
split GFP creates a strong cell-cell adhesion that can stabilize 
otherwise transient synapses. Thus, it is critical to keep in mind 
that using proteins to label synapses could corrupt the normal 
synaptic development and distribution.       

5    Imaging and Quantifi cation of Genetic Synaptic Markers 

  Two-photon microscope technology has taken off considerably in 
recent years and is still the only technique that allows for synapse 
imaging in vivo. This technique is extremely useful for observing 
real-time changes to experimental manipulations and allows inves-
tigators to visualize synapse dynamics. 

 Neurons up to 800 !m below the brain’s surface can be imaged 
[ 43 ]. In some cases it becomes even possible to image even deeper 
brain structures at high resolution such as superfi cial dendrites of 
neurons in CA1 of the hippocampus by removing part of the neo-
cortex and white matter above the hippocampus [ 44 ]. Finally, there 
has been great interest in using two-photon microscopy associated 

4.4  Technical 
Considerations 
of Genetic Labeling
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Microscopy

Genetic Labeling of Synapses



242

with endoscope lenses to image deep within the brain, but several 
technical obstacles to obtain a suffi cient spatial resolution need to 
be solved before this method can be routinely used [ 45 ].  

  As deep structures of the brain are beyond the depth limitation of 
two-photon microscopy in vivo, in vitro time-lapse confocal imag-
ing of brain slices is sometimes carried out to study the dynamics 
of synapse formation [ 38 ,  46 ]. The main concern about this tech-
nique is that the integrity of cultured adult brain slices is dramati-
cally perturbed over long time periods with currently available 
culture techniques [ 47 ], as well as the possibility of abnormal syn-
apse rearrangement due to fl uctuations in culture conditions [ 48 ]. 
Confocal imaging of fi xed slices is much more commonly used to 
study synaptic organization, especially because this method of 
observation is technically straightforward and enables investigators 
to analyze many neurons simultaneously. Time course experiments 
can be performed to observe spine formation over days and 
months, but because only a snapshot of the synapses can be 
obtained in fi xed slices, this technique cannot be used to analyze 
the short-term dynamics of synapse formation in real time.  

  Genetic synaptic markers provide substantial advantages when it 
comes to the quantifi cation of densities of synapses in dendritic or 
axonal domains. With genetically encoded markers, one can, in 
principle, analyze the complete set of a neuron’s excitatory input 
synapses and output synapses, including those not associated with 
structural specializations such as spines or axon terminals. 

 Genetically labeled synapses appear as discrete bright clusters 
that can be semiautomatically detected and measured upon thresh-
olding of images using freely available software packages (e.g., 
ImageJ-based MacBiophotonics). The obtained data about syn-
apse organization can be combined with reconstruction of the 
morphology of individual neurons to obtain the spatial distribu-
tion of synapses along neuronal trees and measures of local cluster 
density. Most of the current analysis is limited to two-dimensional 
projections of 3D image stack. With the advancement of existing 
software tools, analysis in 3D may soon be amenable. 

 The main challenge of these approaches is the still highly 
labor intense reconstruction of neuronal processes, because it is 
essential to attribute genetically labeled synapses to specifi c neu-
ronal domains such as axons or dendrites. One may imagine that 
reconstruction of dendritic and axonal trees of sparsely labeled 
neurons is an easy task to be automated. This however turned out 
to be a formidable challenge [ 49 ]. As a fi rst step in this process, 
accurate semiautomated reconstruction software in 3D (e.g., [ 50 ]) 
could facilitate neuronal reconstruction to then attribute synap-
tic organization to neuronal trees in 3D.   

5.2  Confocal 
Microscopy

5.3  Data Analysis 
and Quantifi cation
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6    Future Directions: Combination of Synaptic Labeling and Transneuronal Tracing 

 Genetic synaptic markers provide powerful tools that can help 
answer many open questions on the development and synaptic wir-
ing of brain circuits when considering their currently existing limi-
tations and caveats. With the continuous efforts to improve the 
existing tools, validation of novel marker proteins for specifi c types 
of synapses, these tools become increasingly more fl exible for spe-
cifi c research questions. They may thus help to fi nd the “tree in the 
forest” among the complex meshwork of neuronal processes and 
synapses in brain circuits. We believe that for many circuits under-
standing the typical wiring diagram of neurons may help to build 
realistic, unifying models of their function without necessarily hav-
ing to know each detail of the entity of each individual’s circuit 
under study. 

 Finally the strength of genetic tools might come into full action 
when genetic synaptic markers and transneuronal tracing will be 
combined. One example for such a dual approach shall be outlined 
here. Once a presynaptic neuron has been labeled at a given time 
point via transneuronal labeling with rabies, it will remain so inde-
pendently of whether the synaptic contact is lost. In contrast to this 
permanent labeling (a trace of the neuron’s connectivity history), 
labeling with genetic synaptic markers, e.g., with PSD-95-GFP, 
will be lost immediately when the synapse is lost. Hence, a combi-
nation of both techniques can serve to identify the history of cells 
that had been presynaptic to the target neuron at one point and 
the current state of synaptic contacts between the neurons.      

7    Appendix: Gene Delivery of Genetic Synaptic Markers with Retroviruses 
and Quantifi cation of Synapses 

 This appendix describes some specifi c procedures to deliver retro-
viruses carrying genetically encoded synaptic markers into the 
brain of rodents. General details about production and titration of 
lentiviral and retroviral vectors can be found elsewhere.  

8    Injection of Viruses into the Brain 

  Viral prep:  It is critical that the viral suspension is very clean. 
During the preparation of the viruses, there will be some cellular 
debris that can be strongly autofl uorescent. To eliminate this debris 
it is useful to centrifuge the viral prep with a 20 % sucrose 
cushion. 

  Stereotaxic injection:  It is critical to minimize the damage to the 
brain during injection. In particular, bleeding associated with the 
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injection will cause very high levels of autofl uorescence that will 
make quantifi cation of synapses very diffi cult. To minimize damage 
it is useful to use thin borosilicate pipettes pulled to an outer diam-
eter of approx. 15–20 !m. It is not advisable to inject through 
metallic needles as this will cause severe tissue damage on the injec-
tion site. Similarly, it is advisable to inject the viral prep slowly, at a 
rate of approx. 1 !l over 5 min. Rapid injection can severely dam-
age and distort the tissue. Regarding the timing of imaging after 
injection, for lentiviral vectors, the expression of the transgene 
peaks as early as 3 days, but there will likely be some acute damage 
in the injection area at this early time. Thus, it is advisable to wait 
at least a week so that the autofl uorescence due to damage is 
resolved before perfusion of the animal.  

9    Acquisition and Analysis of Genetically Labeled Synapses 

 This section describes the procedure that we optimized to visualize 
the synaptic organization of single genetically labeled neurons, 
which can be easily modifi ed for individual experimental needs. 
The procedure is divided into three main steps, and technical issues 
are highlighted that are critical in our experience: preparation of 
the tissue (“Preparation of Tissue”), image acquisition by confocal 
microscopy (“Image Acquisition”), and semiautomated image 
analysis (“Quantifi cation of Synaptic Clusters”). 

      1.    The protocol is described for small rodents, but can be easily 
adapted to other species. Animals are transcardially perfused ini-
tially with phosphate buffered saline (PBS, 1!) for 10–15 s, fol-
lowed by 4 % paraformaldehyde (PFA) for 3–5 min. The  animal 
should become rigid within the fi rst 30 s to 1 min of perfusion 
with PFA. It is optimal to use an overdose of an injectable anes-
thetic drug (such as Ketamin/Xylazin) and to start perfusion 
when the heart is still beating. PBS should be infused at a pres-
sure such that the liver becomes pale within 10–15 s and clear 
PBS fl ows out of the right atrium after this period. It is equally 
important to perfuse with relatively low pressure, because at 
high perfusion pressure, the small capillaries in the brain will 
break and perfusion will not be homogeneous throughout the 
brain. PBS should be set to pH 7.0–7.4 and pre-warmed to 
32–37 °C to prevent contraction of smaller blood vessels in the 
brain. Following PBS, perfusion should be immediately switched 
to room-temperature PFA. Incorrect perfusion leads to delayed 
fi xation with PFA, which results in beaded structures of den-
drites and loss of genetically labeled synaptic clusters. After per-
fusion is complete, the brains are extracted from the skull and 
post-fi xed in 4 % PFA overnight at 4 °C.   

9.1  Preparation 
of Tissue
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   2.    After preparation of fl oating sections with a vibratome (e.g., 
50 !m sections), tissue can be incubated (overnight at 4 °C) 
with primary antibody raised against the fl uorescent protein 
tagged to the synaptic marker. The following day sections are 
rinsed in PBS and stained with a secondary fl uorescent antibody 
for two hours at room temperature. Sections are then washed 
with PBS and mounted with an aqueous mounting medium 
that preserved fl uorescent molecules. This procedure allows for 
the visualization of the neuronal tree and to attribute synaptic 
clusters to a neuron and specifi c dendritic domains. Blocking 
solutions (PBS containing 1 % bovine serum albumin or related 
serum proteins) for antibody incubation usually contain a deter-
gent, i.e., Triton X-100, to permeabilize the tissue. We keep the 
procedure and times as constant as possible to avoid introduc-
ing additional variability, i.e., by differentially affecting the 
brightness of the fl uorescence of the synaptic clusters.      

  Neurons expressing synaptic marker proteins can be conveniently 
imagined using confocal laser scanning microscopy. In most experi-
mental conditions, it is advantageous to image sections that are 
sparsely labeled, where individual neurons are clearly separated from 
each other. In this case it is easy to analyze the full dendritic arbor of 
a single neuron without having to deal with neurites that could 
belong to neighboring cells. Confocal stacks are acquired at high 
magnifi cation (with a 60–63! oil immersion objective) to effi ciently 
capture emitted light from the clustered fl uorescent proteins. The 
pixel size should be suffi ciently small to obtain high intensity of all the 
pixels that are grouped in individual synaptic clusters, and to easily 
distinguish them from the occasionally observed noise that may result 
in random isolated pixels with high intensity. As most synaptic clus-
ters have a size around 1 !m, we found a cluster size between 0.2 ! 0.2 
and 0.3 ! 0.3 !m 2  most reliable for subsequent analysis. Laser excita-
tion intensities should be set to levels that result in little or no obvious 
bleaching of the clusters. This can be easily tested by imaging the 
same neuron twice in the same day and comparing the clusters among 
the two images. A reference section containing neurons with good 
synaptic cluster intensity should be used to guarantee comparable 
acquisition conditions over time. The sensitivity of the photomulti-
pliers (PMT) should be set to a level that clusters just saturate but low 
enough that individual clusters do not become confl uent due to 
overexposure. Similarly, the pinhole size should be kept in the recom-
mended range [ 51 ] for the chosen magnifi cation. Once the settings 
are initially defi ned with a test sample, the conditions should be kept 
constant throughout the different imaging session. Upon acquisi-
tion of confocal stacks, maximum density projections are prepared 
for further image analysis. Two-dimensional projections are gener-
ally used for analysis, as current version of most image processing 
software cannot handle 3D data for quantifi cation.  

9.2  Image 
Acquisition
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  Analysis of densities and distribution of genetically labeled synapses 
can be semiautomated. Fully automated analysis is currently lim-
ited by the still challenging task for computers to reconstruct neu-
ronal trees due to overlap of labeled neurons and discontinuities in 
the processes deriving from histological processing and incomplete 
fi lling with fl uorescent proteins. Thus, reconstruction of processes 
has to be performed individually or at least be supervised. 

 Contrary to reconstruction of dendritic trees, analysis of clus-
ters can be fully automatized provided the original image quality 
has a good signal-to-noise ratio. Signal-to-noise ratio for these 
experiments means high intensity of fl uorescence in the synaptic 
cluster and low levels of autofl uorescent background outside of 
synaptic sites. Similarly, it is important that there is a low level of 
fl uorescence originating from diffusely distributed XFP in the cells’ 
processes outside the synapses. Another potential source of “con-
tamination” with artifactual autofl uorescent clusters can be due to 
lipofuscin granules observed in some brain structures and species. 
The appearance of these autofl uorescent granules is diffi cult to pre-
dict. For example, we have found them in mouse olfactory bulb 
and dentate gyrus, but not in the rat olfactory bulb or mouse neo-
cortex. These autofl uorescent artifacts can be easily diagnosed as 
they are excited by all wavelengths. In contrast, real genetic synap-
tic markers containing XFPs can only be detected at a specifi c 
wavelength (e.g., 550 nm for GFP). In addition, these autofl uores-
cent granules can usually be excluded from analysis as they are 
mostly present in cell bodies. 

 Given these considerations the analysis is relatively 
 straightforward using different analysis software packages. We will 
describe the different steps of analysis and particularly refer to the 
ImageJ- based MacBiophotonics software (  www.macbiophotonics.
ca/    ). Similar procedures can be performed in Metamorph software 
from Molecular Probes. 

 Steps:

    1.    Open maximum density projection ( File > Open ).   
   2.    Defi ne pixel size for subsequent distance measurements 

( Analyze > Set scale ).   
   3.    Split color channels ( Image > Color > Split channels ).   
   4.    Choose the channel that displays the fl uorescent synaptic 

clusters.   
   5.    Set inclusive threshold so that only clusters are included 

( Image > Adjust > Threshold ). The threshold value should be 
kept constant throughout the analysis. Therefore, it proves 
useful to use a reference as described in the acquisition part to 
set the threshold.   

   6.    Draw a contour using the freehand selection tool to defi ne a 
region of interest to measure a specifi c dendritic domain and 
exclude neighboring neurons.   

9.3  Quantifi cation 
of Synaptic Clusters
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   7.    Perform region measurement ( Analyze > Analyze particles ). 
Desired parameter data can be set in the results window 
( Analyze > Set Measurements ) and copied to a data sheet of a 
given statistics program.     

 Measure the length of the neuronal processes in the region of 
interest using the freehand line tool and  Analyze > Measure .    

   References 

    1.    Price JL, Powell TP (1970) The synaptology of 
the granule cells of the olfactory bulb. J Cell 
Sci 7:125–155  

    2.    Woolf TB, Shepherd GM, Greer CA (1991) 
Serial reconstructions of granule cell spines in 
the mammalian olfactory bulb. Synapse (NY) 
7:181–192  

     3.    Briggman KL, Helmstaedter M, Denk W (2011) 
Wiring specifi city in the direction- selectivity cir-
cuit of the retina. Nature 471:183–188  

   4.    White JG, Southgate E, Thomson JN et al 
(1986) The structure of the nervous system of 
the nematode Caenorhabditis elegans. Phil 
Trans R Soc Lond B Biol Sci 314:1–340  

    5.    Mishchenko Y, Hu T, Spacek J et al (2010) 
Ultrastructural analysis of hippocampal neuro-
pil from the connectomics perspective. Neuron 
67:1009–1020  

       6.    Kelsch W, Lin C-W, Lois C (2008) Sequential 
development of synapses in dendritic domains 
during adult neurogenesis. Proc Natl Acad Sci 
U S A 105:16803–16808  

    7.    Livneh Y, Feinstein N, Klein M et al (2009) 
Sensory input enhances synaptogenesis of 
adult-born neurons. J Neurosci 29:86–97  

      8.    Meyer MP, Smith SJ (2006) Evidence from 
in vivo imaging that synaptogenesis guides the 
growth and branching of axonal arbors by two 
distinct mechanisms. J Neurosci 26:3604–3614  

      9.    Niell CM, Meyer MP, Smith SJ (2004) In vivo 
imaging of synapse formation on a growing 
dendritic arbor. Nat Neurosci 7:254–260  

   10.    Ebihara T, Kawabata I, Usui S et al (2003) 
Synchronized formation and remodeling of 
postsynaptic densities: long-term visualization 
of hippocampal neurons expressing postsynap-
tic density proteins tagged with green fl uores-
cent protein. J Neurosci 23:2170–2181  

     11.    Gray NW, Weimer RM, Bureau I et al (2006) 
Rapid redistribution of synaptic PSD-95 in the 
neocortex in vivo. PLoS Biol 4:e370  

    12.    Sheng M (2001) Molecular organization of the 
postsynaptic specialization. Proc Natl Acad Sci 
U S A 98:7058–7061  

     13.    Washbourne P, Bennett JE, McAllister AK 
(2002) Rapid recruitment of NMDA receptor 

transport packets to nascent synapses. Nat 
Neurosci 5:751–759  

     14.    Südhof TC, Jahn R (1991) Proteins of synaptic 
vesicles involved in exocytosis and membrane 
recycling. Neuron 6:665–677  

    15.    Shu F, Ohno K, Wang T et al (2001) 
Developmental changes in PSD-95 and Narp 
mRNAs in the rat olfactory bulb. Dev Brain 
Res 132:91–95  

    16.    Sassoé-Pognetto M, Utvik JK, Camoletto P 
et al (2003) Organization of postsynaptic den-
sity proteins and glutamate receptors in axoden-
dritic and dendrodendritic synapses of the rat 
olfactory bulb. J Comp Neurol 463:237–248  

     17.    El-Husseini AE, Schnell E, Chetkovich DM 
et al (2000) PSD-95 involvement in matura-
tion of excitatory synapses. Science (NY) 290:
1364–1368  

     18.    Kelsch W, Li Z, Eliava M et al (2012) GluN2B- 
containing NMDA receptors promote wiring 
of adult-born neurons into olfactory bulb cir-
cuits. J Neurosci 32:12603–12611  

    19.    Chen JL, Villa KL, Cha JW et al (2012) 
Clustered dynamics of inhibitory synapses and 
dendritic spines in the adult neocortex. Neuron 
74:361–373  

    20.    Chen L, Wang H, Vicini S et al (2000) The 
"-aminobutyric acid type A (GABAA) 
receptor- associated protein (GABARAP) pro-
motes GABAA receptor clustering and modu-
lates the channel kinetics. Proc Natl Acad Sci 
97:11557–11562  

    21.    Jacob TC, Bogdanov YD, Magnus C et al 
(2005) Gephyrin regulates the cell surface 
dynamics of synaptic GABAA receptors. 
J Neurosci 25:10469–10478  

    22.    Pennuto M, Bonanomi D, Benfenati F et al 
(2003) Synaptophysin I controls the targeting 
of VAMP2/Synaptobrevin II to synaptic vesi-
cles. Mol Biol Cell 14:4909–4919  

    23.    Valtorta F, Pennuto M, Bonanomi D et al 
(2004) Synaptophysin: leading actor or walk-
 on role in synaptic vesicle exocytosis? BioEssays 
News Rev Mol Cell Dev Biol 26:445–453  

    24.    Nakata T, Terada S, Hirokawa N (1998) 
Visualization of the dynamics of synaptic vesicle 

Genetic Labeling of Synapses



248

and plasma membrane proteins in living axons. 
J Cell Biol 140:659–674  

   25.    Li Z, Murthy VN (2001) Visualizing posten-
docytic traffi c of synaptic vesicles at hippocam-
pal synapses. Neuron 31:593–605  

    26.    Kaether C, Skehel P, Dotti CG (2000) Axonal 
membrane proteins are transported in distinct 
carriers: a two-color video microscopy study in 
cultured hippocampal neurons. Mol Biol Cell 
11:1213–1224  

    27.    Bergmann M, Lahr G, Mayerhofer A et al 
(1991) Expression of synaptophysin during the 
prenatal development of the rat spinal cord: 
correlation with basic differentiation processes 
of neurons. Neuroscience 42:569–582  

    28.    Wickersham IR, Lyon DC, Barnard RJO et al 
(2007) Monosynaptic restriction of transsyn-
aptic tracing from single, genetically targeted 
neurons. Neuron 53:639–647  

      29.    Wickersham IR, Feinberg EH (2012) New 
technologies for imaging synaptic partners. 
Curr Opin Neurobiol 22:121–127  

    30.    Scott CA, Rossiter JP, Andrew RD et al (2008) 
Structural abnormalities in neurons are suffi -
cient to explain the clinical disease and fatal 
outcome of experimental rabies in yellow fl uo-
rescent protein-expressing transgenic mice. 
J Virol 82:513–521  

    31.    Marshel JH, Mori T, Nielsen KJ et al (2010) 
Targeting single neuronal networks for gene 
expression and cell labeling in vivo. Neuron 
67:562–574  

     32.    Feinberg EH, Vanhoven MK, Bendesky A et al 
(2008) GFP reconstitution across synaptic 
partners (GRASP) defi nes cell contacts and 
synapses in living nervous systems. Neuron 
57:353–363  

    33.    Cabantous S, Terwilliger TC, Waldo GS (2005) 
Protein tagging and detection with engineered 
self-assembling fragments of green fl uorescent 
protein. Nat Biotechnol 23:102–107  

    34.    Park J, Knezevich PL, Wung W et al (2011) A 
conserved juxtacrine signal regulates synaptic 
partner recognition in Caenorhabditis elegans. 
Neural Dev 6:28  

     35.    Kim J, Zhao T, Petralia RS et al (2012) 
mGRASP enables mapping mammalian synap-
tic connectivity with light microscopy. Nat 
Methods 9:96–102  

     36.    Yamagata M, Sanes JR (2012) Transgenic 
strategy for identifying synaptic connections in 
mice by fl uorescence complementation 
(GRASP). Front Mol Neurosci 5:18  

    37.    Micheva KD, Smith SJ (2007) Array tomogra-
phy: a new tool for imaging the molecular 
architecture and ultrastructure of neural cir-
cuits. Neuron 55:25–36  

     38.    Toni N, Teng EM, Bushong EA et al (2007) 
Synapse formation on neurons born in the 
adult hippocampus. Nat Neurosci 10:727  

      39.    Briggman KL, Denk W (2006) Towards neural 
circuit reconstruction with volume electron 
microscopy techniques. Curr Opin Neurobiol 
16:562–570  

    40.    Sanes JR (1989) Analysing cell lineage with a 
recombinant retrovirus. Trends Neurosci 12:
21–28  

    41.    Livneh Y, Mizrahi A (2012) Experience- 
dependent plasticity of mature adult-born 
 neurons. Nat Neurosci 15:26–28  

    42.    Scheiffele P (2003) Cell-cell signaling during 
synapse formation in the CNS. Annu Rev 
Neurosci 26:485–508  

    43.    Helmchen F, Denk W (2005) Deep tissue two- 
photon microscopy. Nat Methods 2:932–940  

    44.    Mizrahi A, Crowley JC, Shtoyerman E et al 
(2004) High-resolution in vivo imaging of hip-
pocampal dendrites and spines. J Neurosci 24:
3147–3151  

    45.    Flusberg BA, Cocker ED, Piyawattanametha W 
et al (2005) Fiber-optic fl uorescence imaging. 
Nat Methods 2:941–950  

    46.    Galimberti I, Gogolla N, Alberi S et al (2006) 
Long-term rearrangements of hippocampal 
mossy fi ber terminal connectivity in the adult 
regulated by experience. Neuron 50:749–763  

    47.    Berdichevsky Y, Sabolek H, Levine JB et al 
(2009) Microfl uidics and multielectrode array- 
compatible organotypic slice culture method. 
J Neurosci Methods 178:59–64  

    48.    Kirov SA, Petrak LJ, Fiala JC et al (2004) 
Dendritic spines disappear with chilling but pro-
liferate excessively upon rewarming of mature 
hippocampus. Neuroscience 127:69–80  

    49.    Donohue DE, Ascoli GA (2011) Automated 
reconstruction of neuronal morphology: an 
overview. Brain Res Rev 67:94–102  

    50.    Brown KM, Barrionuevo G, Canty AJ et al 
(2011) The DIADEM data sets: representative 
light microscopy images of neuronal morphol-
ogy to advance automation of digital recon-
structions. Neuroinformatics 9:143–157  

    51.    Hanrahan O, Harris J, Egan C (2011) Advanced 
microscopy: laser scanning confocal micros-
copy. In: O’Driscoll L (ed) Gene expression 
profi ling. Humana, Totowa, NJ, pp 169–180    

Carlos Lois and Wolfgang Kelsch


